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Guide Description

The purpose of this guide is to lay out the steps for deployment the OS upgrade from the M365 skus
across your network. This guide is assuming you have the M365 Business, M365 E3, or M365 E5 License.
After the you complete this guide you will have:

Run an assessment for Windows 10 Upgrade Readiness for all the devices on your network
Created Windows 10 Installation Media

Downloaded and Configured MDT and WDS to deploy the Windows 10 Upgrade

Tested the upgrade on 2 pilot devices

e Configured WDS and MDT for Light Touch Installation (LTI) to all users on your network

**Disclaimer**

This guide is meant to provide best practices for Windows 10 Upgrade readiness and broad
deployment across your network. It is meant to be used as a template, but the settings configured
will not be the same in all use cases. You must access all the devices in your network to decide how
many different versions of the WIM file you need to create to match the compatibility of the
workstation. Pax8 is not liable for any configuration you create that do not meet the customers
standards. As a best practice, test all configurations with a pilot group before moving to broad
deployment across an entire organization



Pre-Flight Checklist

Have Local
Admin ID on all
Workstations

Baseline System Access to Apps you want 2 Pilot Devices

Requirements Primary DC to deploy to Test

a. Have Local Admin ID on all Workstations
i.  We need this when running the Microsoft Assessment and Planning toolkit
ii. Workstations must be turned on for this tool to run an assessment on that
device
b. Baseline System Requirements on Sever:
i. Microsoft Deployment Toolkit:
1. Supported Operating System

a. Windows 10, Windows 7, Windows 8, Windows 8.1, Windows
Server 2008 R2, Windows Server 2012, Windows Server 2012
R2, Windows Server 2016, Windows Server 2019

2. Other Requirements

a. The Windows ADK for Windows 10, version 1809 or later, is
required for all deployment scenarios.

b. Configuration Manager, version 1810 or later, is required for
zero-touch installation (ZTl) and user-driven installation (UDI)
scenarios.

¢. Access to Primary DC
i. This is where we will be spending most of our time during setup
ii. This is where we will run and install the following
1. Microsoft Assessment and planning toolkit
2. MDT
3. WDS
d. Apps you want to Deploy
i. Part of the configuration for MDT allows us to add applications to our
deployment. | do not cover that in this guide but can be helpful if you want to
push out any on-premise applications. | recommend using Intune for this
feature.
e. Choose 2 pilot devices you want to enroll into Intune
i. These devices we will be using to test our deployment share and configure our
bootstrap.ini file so the broad audience has a LTI (Lite touch installation)
experience
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Install the Microsoft Assessment and Planning Toolkit

We want to perform an assessment on the computers in our network to make sure they are compatible
for the Windows Upgrade. The Microsoft assessment and planning toolkit allows us to scan all the
computers in our Active Directory or by scanning a certain IP range and tells us which devices are ready
for the upgrade.

1. Go to the following link on your AD server and download the Microsoft Assessment and
Planning Toolkit: https://www.microsoft.com/en-us/download/details.aspx?id=7826

& Microsoft Assessment and Planning Toolkit — X

4 Welcome to the Setup Wizard for Microsoft Assessment and
Planning Toolkit.

The wizard will configure this product on your computer. Click Next to continue or
Cancel to exit the wizard.

T

2. Run through the wizard to install:

& Microsoft Assessment and Planning Toolkit — X

Please wait for the wizard to finish configuring Microsoft Assessment and Planning Toolkit.

Status:



https://www.microsoft.com/en-us/download/details.aspx?id=7826

3. Go to start and open the program:

v 050 2 e d

n Microsoft Assessment and Plannin...

[ S
(, Google Chrome >_ p3

O . . N Windows Windows
Microsoft User Experience Virtuali... Server Manager ~ PowerShell PowerShell ISE

Expand ~

. =
Most used : =

Windows
Deployment Workbench Administrativ... Task Manager Control Panel

L
g Snipping Tool

e. Internet Explorer l‘:s E‘ m

Remote

4. Click Desktop, then collect inventory data under Windows 10 Readiness

& Microsoft Assessment and Planning Toolkit

File View Tools Help

(

€ + [\ » Desktop »
Overview |} Desktop
Cloud / Steps to complete
Desktop &3 Collect inventory data
Server Scenarios

Desktop Virtualization =T |
M Windows 10 Readiness
Server Virtualization

This scenario is unavailable until you do the
following:
Database R
Collect inventory data

Usage Tracking

Crnranmant



5. Choose Windows Computers and click next:

Lok

- Discovery Methods

3 Active Directory
Credentials

| & Inventory and Assessment Wizard X

"‘3 Inventory Scenarios

)| Active Directory

The MAP Toolkit helps you to collect information for
several different inventory scenarios. The scenarios you
choose determine the technologies used to collect
information from computers in your environment.

Choose your scenario. b

Options L
| All Computers [ JLirwUNIX cornputers
Credentials [ ]VMware computers
[ ] Active Devices and Users hd
Credentials Order
Summary Description

This inventory scenario uses WMI to collect hardware, device,
and software information about Windows-based computers in
your environment, including Microsoft Office, SQL Server, Sha

Collector Technologies: WML

< Previous Finish

6. Choose you methods:

S

Inventory Scenarios

— Use Active Directory Domain Services (AD DS)

Active Directory
Credentials

Active Directory
Options

Scan an IP Address
Range

All Computers
Credentials

Credentials Order

Summary

Select which methods to use to discover computers.

D Use Windows networking protocols

[ ] Use System Center Configuration Manager (SCCM)
Scan an IP address range

[ ] Manually enter computer names and credentials

D Import computer names from a file

s

‘ Select this checkbox to import computer

| < Previous || Next > | Finish

[




7. [If using AD DS, enter necessary info:

' & Inventory and Assessment Wizard X

c

54

M

" % Active Directory Credentials

Inventory Scenarios ~ Specify the logon information used to connect to the
Active Directory forest and discover domain-joined com

Discovery Methods (* Indicates reauired field

_ Qornain* : wraj rec{}rds-cﬂm i
: smicrosoft.com o

Active Directory

Options Domain account*: wrajrecords\nross
| - user@doma

¢ Scan an IP Address

Range This account does not require administre

All Computers Password*: “ |
Credentials -

Credentials Order

Summary

< Previous || Next > || Einish || gancel[\hg !

T

8. [If using IPs, enter range:

& Inventory and Assessment Wizard X

o

?ﬁ Scan an IP Address Range

Inventory Scenarios  Spedify the IP address ranges to scan for computers and
devices.
Discovery Methods

- Enter the IP address ranges below. Press Tab to insert a new
TOW.

All CDmPuters IP addresses between the starting and ending values will be
Credentials included. A maximum of 100,000 addresses are allowed.
Credentials Order
IP address ranges:
Summary
Starting Address Ending Address

< Previous || Next > || Finish || Cancel |




9. Ensure you add an administrator account with local admin access to all computers

Inventory and Assessment Wizard

ers Credentials

Please supply account credentials for the platforms and technok you've ch
These credentials will be used to connect to the machines you've specified.

&
crevon | [ot> ] o[ o

10. Finish the wizard till completion

% Inventory and Assessment Wizard b X

Inventory Scenarios ~ Your selections are summarized below, including any
b detected errors.

,| Discovery Methods

| Scan an IP Address  Review your selections and resolve any detected errors before

J Range starting the inventory. L]
All Computers [ Errors A(
Credentials - - The WMI collector technology requires at least one All Compi

1§ Credentials Order = Summary F

| £ Inventory Scenarios
_ - Windows computers
... Selected Collector Technologies: WMI
= Discovery Methods
. Active Directory Domain Services: Not Selected
Windows Networking protocols: Not Selected
~~5CCM Server and Credentials: Not Selected
(= IP Address Ranges

~10.1.1.1 - 10.1.1.50
= All Cammniters Credentials

< Previous || Next > || Finish H Cancel |



11. After the assessment runs, you will get an excel sheet with a summary:

a.

A

Font

client operating system.

Bl Windows 10 Readiness

B

. Before Hardware Upgrades

gnment

1 |Windows 10 Assessmenk Summary for Client Computers
This worksheet provides a summary of Windows 10 readiness information for computers that are already runnin,

Windows 10 Assessment Summary for Client Computers

. After Hardware Upgrades

Meets Minimum System 70 232
Requirements
6 Not Ready for Windows 10 162 0
Insufficient Data (Not 31 31
7 Inventoried)

Insufficient data typically means that the computer was turned off or that there were not

sufficient permissions on that device with the credentials provided

Client Assessment tab shows a list of the devices in a more detailed view:

| Iwindows 10 Assessmenl Summary for Client Computers

This worksheet provides a summary of Windows 10 readiness information for computers that are a

client operating system.

Meets Minimum System
Requirements

232

Not Ready for Windows 10

162

Insufficient Data (Not
" Inventoried)

31

31

» Summary AssessmentValues

¥

ClientAssessment

AfterUpgrades

DewviceSur
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1.

AfterUpgrades shows what you need to do to upgrade:

Windows 10 Minimum Ready Computers After Hardware Upgrades

This worksheet describes computers that are not currently able to run Windows 10 and the hardware upgrades requil

the minimum system requirements for Windows 10.

Computer Name
Map-7-
x64.map.test. CONTOSO.COM

- IP Address

10.217.74.28;fe80::4836:516¢:1d5¢:
3635;200!:4898@:3236:4836:516(
:1d5¢c:36a5

Intel(R) Xeon(R) CPU
@ 2.13GHz, 64 bit

Map-81-
multi.map.test.CONTOSO.COM

172.16.0.218;fe80::3435:8373:4caa:
€948
10.217.72.227;fe80::3409:2€00:9be
:19b¢;2001:4898:0:323d:d85d:5f6
7:1593:a55b;2001:4898:€0:323d:79
c4:3acf:7e0d:3d22;2001:4898:0:

Intel(R) Xeon(R) CPU
@ 2.13GHz, 64 bit

MAP-81-
x64.map.test. CONTOSO.COM

10.217.72.236;fe80::e592:bb87:ea
©2:0e08;2001:4898:20:323d:f1a9:1
d7c:d1fd:ccd7;2001:4898:€0:323d:
9058:13cf:eb19:9821;2001:4898:20

Intel(R) Xeon(R) CPU
@ 2.13GHz, 64 bit

Py

Map-81-x64-
cn.map.test.CONTOSO.COM

» Summary

10.217.74.29;fe80::7012:3€67:b913
:4393;2001:4898:0:323d:d0bd:8d0

AL B rf AN 1400010212120

Client

Intel(R) Xeo cPU
@ 2.13GH bit

AfterUpgrades Dev

- Memory
L5630 |Upgradeto:
L5630 |Upgradeto:
L5630 |Upgradeto:
L5630 |Upgradeto:

Install the Windows 10 Installation Media

this on your AD server:

Microsoft 365 admin center

Eo Device Management (=7

&

o

}

Set up device enrollment el
Configure device profiles 3

Create app policies

Device policies —

@

O

f=]

Train yourself i)

& Azure Active Directory =1

Customize sign in
Enable password reset

Add an application

Device actions >

Deploy Windows with AutoPilot
Remove company data
Factory reset

Manage Office deployment

Message center >

£ Support

New service request

View service requests

am Windows 10 Upgrade

4 Install upgrade

=7 Share the download link

) | 1

Create installation media

Troubleshoot installation

Login to your admin center and scroll down to the Windows 10 Card on your Dashboard. Here
you can click on a link to download the installation media. **NOTE** you will want to install

@ Need help? [IFeedback
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https://www.microsoft.com/en-us/software-download/windows10

Download Windows 10

Windows 10 October 2018 Update now available
The Update Assistant can help you update to the latest version of Windows 10. To get started, click Update now.
Update now

Privacy

Create Windows 10 installation media

To get started, you will first need to have a license to install Windows 10. You can then download and run the
media creation tool. For more information on how to use the tool, see the instructions below.

Download tool now

Privacy

4 wEEEEE O

2. Click on Download tool now to launch the Wizard. You will want to run this wizard for upgrades
either on the existing computer or to create the ISO file to upgrade other computers. First Agree
to the terms and conditions:

4 Windows 10 Setup — X

Applicable notices and license terms

gto

‘MICROSOI-—I' SOFTWARE LICENSE TERMS

MICROSOFT MEDIA CREATION TOOL

IF YOU LIVE IN (OR ARE A BUSINESS WITH A PRINCIPAL PLACE OF BUSINESS IN) THE
UNITED STATES, PLEASE READ THE "BINDING ARBITRATION AND CLASS ACTION
WAIVER"” SECTION BELOW. IT AFFECTS HOW DISPUTES ARE RESOLVED.

These license terms are an agreement between you and Microsoft Corporation (or one of its
affiliates). They apply to the software named above and any Microsoft services or software updates
(except to the extent such services or updates are accompanied by new or additional terms, in which
case those different terms apply prospectively and do not alter your or Microsoft's rights relating to
pre-updated software or services). IF YOU COMPLY WITH THESE LICENSE TERMS, YOU HAVE THE
RIGHTS BELOW. BY USING THE SOFTWARE, YOU ACCEPT THESE TERMS.

1. INSTALLATION AND USE RIGHTS.
a) General. You may install and use one copy of the software to develop and test your
applications, and solely for use ‘n Windows. You may make one backup copy of the

software for the sole purpose or reinstalling the software.

b) Third Party Software. The software may include third party applications that Microsoft,

et o (o) ey (oo 5 aon o Ty Ny ey [ S Y Ry



https://www.microsoft.com/en-us/software-download/windows10

3. Inthis guide, we are going to create the installation media:

£3 Windows 10 Setup

- X

What do you want to do?

O Upgrade this PC now

@ Create installation media (USB flash drive, DVD, or ISO file) for another PC

4. Forthe “Upgrade this PC Now” option, please watch this short video:
https://www.microsoft.com/en-us/videoplayer/embed/RE201WL

5. Chose 32-bit or both:

¥4 Windows 10 Setup

Plea:
Language
Edition

Architecture

Select language, architecture, and edition

ntir

English (United States) b%

64-bit (x64) -

32-bit (x86
64-bit (x64)
Both

Vg \
paxs

\! ‘/“.
\ 9
N —
—= g 4


https://www.microsoft.com/en-us/videoplayer/embed/RE201WL

6. Choose which media to use, we will be downloading the ISO file:

£ Windows 10 Setup

7. Select your destination to save the ISO:
\

=

£ Select a path

&« v « Desktop > Windows 10 1SO v 0

Organize ~ New folder ==
= Pictures 2 Name
BitTitan Migratio
. No items match your search
Camtasia ;
Microsoft Teams
7 OneDrive - PAX8
@ OneDrive - PAX8

f PAXs

Sales Engineers -

=4 This PC
v <

File name: | Windows 10 Pro I1SO
Save as type: |1SO File (*.iso)

 Hide Folders Cancel




8. Allow the download to complete, click Finish when done:

& Windows 10 Setup - X

Downloading Windows 10

Feel

Progress: 1%

9. You will now have the ISO download to burn to a DVD:

= | Windows 10 1SO - [m] X
Bl - °
« v » ThisPC » Desktop » Windows 10150 v U »p

Jat
# Quick access
m Desktop Windows 10 Pro 1SO
& Downloads
Documents
= Pictures
BitTitan Migrations
Camtasia
Microsoft Teams Ch
7 OneDrive - PAX8
@ OneDrive - PAXS
fi Paxa
Sales Engineers - Sa
% This PC
& Network

1item
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Install WDS and MDT

Windows Deployment Services enables you to deploy the Windows Operating system over your
network. It can also listen for PXE boot request. The Microsoft Deployment toolkit (MDT) allows us to
create custom WIM files in a deployment share. We will be putting WIM files that we create with MDT
into the boot images section of WDS so that computers are immediately prompted to upgrade when the
boot their device.

1. Install WDS
a. Addroles and features
Server Manager * Dashboard @1 anag

_ WELCOME TO SERVER MANAGER

o Configure this local server

ige Services >

QUICK START

2 Addroles and fdmtures

3 Add other servers to manage

WHAT'S NEW
4 Create a server group

5 Connect this server to cloud services

b. Role Based Assignment

=, Add Roles and Features Wizard — Od K

DESTINATION SERVER

Select installation type MDTlesting

Before You Begin Select the installation type. You can install roles and features on a running physical computer or virtual

machine, or on an offline virtual hard disk (VHD).
Installation Type

(® Role-based or feature-based installation
Server Selection ) . ) .
Configure a single server by adding roles, role services, and features.

(O Remote Desktop Services i ion

Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployment.

< Previous l I Next > Install




c. Choose what server | want to install on
d. Choose Windows Deployment Services

Select one or more roles to install on the selected server.

Roles Desc

~ Winc
prov

["] Active Directory Lightweight Directory Services
Active Directory Rights Management Services
Device Health Attestation of.ra
DHCP Server Winc
DNS Server ol
Fax Server

File and Storage Services (1 of 12 installed)
Host Guardian Service

Hyper-V

MultiPoint Services

Network Controller

Network Policy and Access Services

Print and Document Services

Remote Access

0 1 o

incows Deployment Services
Windows Server Essentials Experience
[] Windows Server Update Services =

e. Click Add Features>Next>Next>Next>Next>Install
f.  Wait for installation to complete:

Add Roles and Features Wizard — O X

DESTINATION SERVER

Installation progress MDTTesting [y

View installation progress /

o Feature installation

Installation succeeded on MDTTesting

Remote Server Administration Tools
Role Administration Tools
Windows Deployment Services Tools

Windows Deployment Services

Deployment Server
RE‘SUP& Transport Server

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

< Previous Next > Close Cancel




2. Goto Tools>Windows Deployment Services

T Server Manager - ] b4

@ ~  Server Manager * WDS -@ | l’, Manage  Tools  View  Help
Component Services
B=  SERVERS Computer Management
& Dashboard E All servers | 1 total Defragment and Optimize Drives
i Local Server Flrce o @~ @~ Disk Cleanup
B Al servers Event Viewer
B§ File and Storage Services P | ServerName  IPv4 Address Manageability Last Update Wi ROlineler

L MDTTesting 100295 Online - Performance counters not started 4/4/2019 6:48:13 PM 003} Microsoft Azure Services

ODBC Data Sources (32-bit)
ODBC Data Sources (64-bit)

Performance Monitor

Print Management
Resource Monitor
Services

System Configuration
System Information

EVENTS Task Scheduler

All events | 0 total “ | Windows D1Q|°ymem Saicas

Windows Firéwall with Advanced Sec
Windows Memory Diagnostic
Windows PowerShell

3. Right click on Server>Configure Server

* Windows Deployment Services
File Action View Help
&= |5 4|

i Windows Deployment Services Windows Deployment Services

v 33 Servers
=i, MDTTestina . .
n Act ﬁgnﬁgure Server ﬂ Windows Deployment Services

Remove Server

Windows Deployment Services enables you to deploy Windo
Refresh
This Microsoft Management Console (MMC) snap-in enables
Help Services. You can perform tasks including adding images, cor
properties. You can also manage your server using the WDSU

To manage a server from this snap-in, you must add it first. Ti
Add Server.




4. Integrate with AD

Services Windows Denlovment Services

! Windows Deployment Services Configuration Wizard x

& Install Options

Select one of the following options:
@®integrated with Active Directory;
This server is a member of an Active Directory Domain Services (AD DS) domain,
or a domain controller for an AD DS domain.

(O Standalone server

Configure the server so that it is standalone, operating independently of Active
Directory.

| <Back [ Net> ]| Cancel

5. Configure the following:

rvices Windows Denlovment Services

! Windows Deployment Services Configuration Wizard X

PXE Server Initial Settings

You can use these settings to define which client computers this server will respond to. Known clients are b
the clients that have been prestaged. When the physical computer perfforms a PXE boot, the operating
system will be installed based on the settings that you have defined.

Select one of the following options:
(O Do not respond to any client computers
O Respond only to known client computers
(® Respond to all client computers (known and unknown)
{Require administrator approval for unknown computers. When you select this option, you must

E]fa;pmve computers using the Pending Devices node in the snap-in. Approved computers will be
iadded list of prestaged clients.

| <Back [ Net> | | Camcel |




6. You should see the following:

File Action View Help
e nmcz Bm

8 Windows Deployment Services w2012r2dep.deploy.com
4 §7 Servers T
. . Name
“Maza?.mm ._EI i
p 4l Bootimages 3::::: 9 )
b 5 Pending Devices .ng!.‘l-:e_ _
b @@ Multicast Transmissions |3} Multicast Transmissions
b 3 Dvivers 4 Drivers
b & Active Directory Prestaged Devices

7. Make sure the service starts correctly:

File Action View Help
o 2m as B

§ Windows Deployment Services
4 33 Servers _ i

4| & w2012r2dep ==+
1 = Ml'f o Images
b 2 Install .
b 4 Bootim  Remove Server S
b 8 Pending ™y Tacks ,
b 3} Multica 4
b _m Active Director Refresh Restart
Export List...
Help

o Successfully started Windows Deployment Services.
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Install MDT: https://www.microsoft.com/en-
us/download/confirmation.aspx?id=54259 and WADK: https://docs.microsoft.com/en-
us/windows-hardware/get-started/adk-install

a. Download the Windows ADK for Windows 10, version 1809

b. Download the Windows PE add-on for the ADK
Run through Wizard

a. Configure the following for WADK:

@Windlm'. Assassment and Deployment Kil - Winduss 10 — =

Select the features you want to install

Click a feature name for more information.

[] Application compatibilin Tools User State Migration Tool (USMT)

[¥] beployment 1ooks Size: 5127 MB

|7Irraging And Configuration Lesigner (1019 loals Lo mmigrale wser dala from g previows inslallation of
[ Confiuuation Dessgnes Windows o a rew installation.

Inchedes:

[i. ol Actiation Managesment Tool [WAMT) . arslales luel
[+ Wirkderass Pecfarmanee Toclkit * LoadState too
. + LISMATLUl: too
[+ Wicrosoft Uses Experiance Virualization (UE-] Template

[ ] wadia sxperience analyzar

L

Estimaled disk space reguired: 1.0 GB
Disk space avanlable: 1160 GB
| Back Inztall Cancel |

b. Search for Deployment Workbench under the start menu to make sure everything
installed correctly:

i
Volume Activation Management T... ‘ ¥ g

Windows
Windows Imaging and Configurati... Administrativ... Task Manager Control Panel

Windows System Image Manager

Deployment and Imaging Tools En... a® 'E‘ I - I

Remote
UDI Wizard Designer Desktop... Event Viewer File Explorer

A

Deployment Workbench

Customer Feedback Options

Configure ConfigMgr Integration


https://www.microsoft.com/en-us/download/confirmation.aspx?id=54259
https://www.microsoft.com/en-us/download/confirmation.aspx?id=54259
https://docs.microsoft.com/en-us/windows-hardware/get-started/adk-install
https://docs.microsoft.com/en-us/windows-hardware/get-started/adk-install
https://go.microsoft.com/fwlink/?linkid=2026036
https://go.microsoft.com/fwlink/?linkid=2022233

pod

10. For the Windows PE installation wizard, specify Installation on this computer:

ﬁ Windows Assessment and Deployment Kit Windows Preinstallation Environment Add-ons - Windows 10 — X

Specify Location

@® Install the Windows Assessment and Deployment Kit Windows Preinstallation Environment Add-ons -
Windows 10 to this computer

Install Path:

C:\Program Files (x86)\Windows Kits\10\ Browse...
* Windows Kit commeon installation path used

O Download the Windows Assessment and Deployment Kit Windows Preinstallation Environment Add-ons -
Windows 10 for installation on a separate computer

Download Path:

C:\Users\nross\Downloads\Windows Kits\10\ADKWinPEAddons Browse...
Estimated disk space required: 5.7 GB
Disk space available: 1044 GB

Next ‘ l Cancel

11. Create new Deployment Share
a. In Deployment workbench>New Deployment share

ﬁ DeploymentWorkbench - [Deployment Workbench]
| File Action View Help

= H

iTf1 Deployment Workbench |
» .} Information Center
> o Deployment S-----

' Deployment Share osoft Deplo!
Opéh Deployment Share
licrosoft Deployi

Refresh nce for automat
tandardizing des
Help juration manage

MDT supports deployi

emhedded nneratinn




b. Customize the following settings to your environment:

Moz Deployrment Shane Wizard

98 o

_ Speciy the kcation of the networ: shans for this deployment type.
Share
Descrpsrve Name Deployment share path:
Optona [ | e |
Summary
Progress
Corfimalion

[

| Preven Concel

Specify the share name to be used with the specified local path. ¥ the share already exists on this
deployment share

computer, it must point to the path specified for this

Full path UNC path:  \MDTTesting\DeploymertShare$

Previous



Mew Deployment Share Wizard

? Descriptive Name

Path Specify a descriptive name for the deployment share.

Povous | [ Net ]| Cancel |



New Deployment Share Wizard

98 ome

When peforming deployments. the behavior of the Deployment Wizard can be customized by tuming
varous wizard panes on or off. For those that are not desired, modify the defaults below as appropriate.
Ask f a computer backup should be peformed.

[ Ask for a product key.

[ Ask to set the local Administrator password.

[4 Ask f an image should be captured.

[ Ask # BitLocker should be enabled.

N

These settings can be changed later by modifying the rules defined for the deployment share.

New Deployment Share Wizard X

-

Path Al of the necessary details have been specfied. Please review the values below.
Share
Descriptive Name Detais.
Path: D:\DeploymentShare
| Upgrade: False
Confimation | ShareName: Deployment Share$
Description: MDT Deployment Share
| Ask about Backup: True

Ask for Product Key: False
Ask for Admin Password: ==
Ask about Image Capture: True
Ask about BtLocker: True

Click next to execute the requested action.

| Prevous [ Net | Conce



c. Click View Script to get a custom powershell script you can use to implement
the same settings to other customers:

New Deployment Share Wizard X

@ Confirmation

[Ereating share D ‘with path D:\D g [ OeploymentWorkbe eployment Workbench\Deployment Shares|
Share created by . . File Action View Help
Performing the operation “New drive” on target “Name: DS001 Provider- MicrosoftDeployment Tookit\MI
mmamwm’::m-wm' ® = | [ 3 NewdP - Notepad - u} %
;:'dﬁ’:nwwlwﬁwﬂmm“ - ﬁ:ﬂ“: File Edit Format View Help )
share * opened & Nw-tterl -Path "D:\DeploymentShare” -ItemType directory

New-SmbShare -Name "DeploymentShare$” -Path "D:\DeploymentShare" -FullAccess Administrators

Import-Module “C:\Program Files\Microsoft Deployment Toolkit\bin\MicrosoftDeploymentToolkit.psdl™

new-PSDrive -Name "DS@@1" -PSProvider "MDTProvider" -Root "D:\DeploymentShare" -Description "MDT Deployment Share™
-NetworkPath “\\MDTTesting\DeploymentShare$" -Verbose | add-MDTPersistentDrive -Verbose

|Adding MDT drive DS001 to the persisted drive list
Successfully added MDT drive DS001 to the persisted drive st

< \ >

d. You will now see the following:

hJ FolEd = | m=a

ﬁ Deployment Workbench

> L.J Information Center

v A Deployment Shares
v [ MDT Deployment Share (D:\DeploymentSI

[ Applications

ﬁ Operating Systems

[; Out-of-Box Drivers

| Packages

_) Task Sequences

[J Advanced Configuration

[a Monitoring

Name

¢4 MDT Deployment Share (D:\De...

W

WOW WY Y Y Y




)

TR

Import Your OS

1. Add your OS to the Deployment Workbench

a. Go to File Explorer and create a new Folder in your D: drive called Win10Source
| Drive Tools ~ Temporary Storage (D)
e Share View Manage
[ o » This PC » Temporary Storage (D) v U | Search Tempor:
Name Date modified Type
ess
, * DeploymentShare 4/4/2019 7:48 PM File folder
g * Win10source ’ 4/5/2019 7:13 PM File folder
ads -
DATALOSS_WARNING_README 4/3/2019 4:47 PM Text Docur
ants »
*
g N
b. Copy the files from the DVD drive from part one of this document and paste them into

this folder:

s | Drive Tools  DVD Drive (F) ESD-I1SO _

{ome Share View Manage
[ 4 > ThisPC » DVD Drive (F)) ESD-ISO » v | Search DVD Drive (F)
~
Name Date modified Type
access
ktop * boot 3/12/2019 8:16 AM File folder
efi 3/12/2019 8:16 AM File folder
loads o+
sources 4/5/2019 6:55 PM File folder
t g
Hments support 3/12/2019 816 AM  File folder
res o 5] autorun 3/12/2019 8:09 AM Setup Informatic
ces A [ bootmgr 3/12/2019 8:09 AM File
’C D bootmgr.efi 3/12/2019 8:09 AM EFI File
L] setup 3/12/2019 8:09 AM Application
ktop
uments

nloads
iic

ares



Import Operating System Wizard

g‘ OS Type

WDS Server
Destination

c. Right click on Operating Systems>Click Import Operating System

File Action View Help

e zn=H

ﬁ DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D:\DeploymentShare)\Operating Systems]

ﬁ Deployment Workbench Name
> L.} Information Center
w [ Deployment Shares
v [ MDT Deployment Share (D:\DeploymentS|
> [3 Applications
[, Operating Systame

Description

There are no items to show in this view.

5 [ Out-of-BoxDri_ Import Operating System [
> L Packages New Folder
5> L Task Sequence )
> [ Advanced Con View
> [a Monitoring Refresh
Export List...
Help

d. Choose Custom Image file and choose the boot.wim file we moved into the D: Drive:

Choose the type of operating system to add.
O Full set of source fies

The operaling systeggbeing added consists of source files from a Windows DVD, CD, or equivalert.

(@) Custom image file
Add a captured image (WIM file) that you wish to deploy.

O Windows Deployment Services images
Add the images avaiable on a specic Windows Deployment Services server.

Jpen X
< <« Win10source > sources » v O Search sources P
Organize v New folder = @
PS
[£ Documents # A  Name Date modified Type
B Pictures~ # dimanifests 4/5/2019713PM  File folder
sources en-us 4/5/2019 7:13 PM File folder
[ This PC etwproviders 4/5/2019 7:13 PM File folder
S inf 4/5/2019 7:13 PM File folder
I Desktop N
migration 4/5/2019 713 PM File folder
£| Documents replacementmanifests 4/5/2019 :13PM  File folder
¥ Downloads s 4/5/20197:13PM  File folder
J') Music uup 4/5/2019 7:13 PM File folder
& Pictures vista 4/5/20197:13PM  File folder
B Videos Xp 4/5/2019 7:13 PM File folder
. i 4, 19 6:51 PM WIM Fil
i, Windows (C || boot.wim /5/2019 65 ile
== Temporary Stora <
File name: | bootwim v | | WIM (*wim) v|
| Open | ‘ Cancel ‘




e. Set up files are not needed:

mport Operating System Wizard x
i
Selup N
05 Type Specify operating system setup files.
Source
@ Setup files are not needed
Dot cop ry s s
'WDS Server
Destination
Summary O Copy Windows 7, Windows Server 2008 R2. o later setup files from the specfied path
Progress Specify a directory containing the Windows 7, Windows Server 2008 R, or later setup files that
Confirmation should be used to install this custom image. These files should match the version of Windows being
installed, and are only needed  the files are not available in ancther available 0S.
Setup source directory:
| Bowse..

f. Continue till completion:

ﬁ DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D:\DeploymentShare)\Operating Systems]
File Action View Help

== H

ﬁ ‘Depluyment Workbench Name Description Platform Build
> & Igfo:'matlcn E:”te' 2 Microsoft Windows PE (x64) in Upgrade Win 10 bo... Microsoft Windows PE (x64) x64 10.0.1
v (3 Deployment Shares A Microsoft Windows Setup (x64) in Upgrade Win 10... Microsoft Windows Setup (x64) x64 10.0.1

v [ MDT Deployment Share (D:\DeploymentS|
> [% Applications
H Operating Systems
> [; Qut-of-Box Drivers
> L Packages
[ Task Sequences
> [ Advanced Configuration
> [y Menitoring




Create a New Task Sequence

1. Create a new task Sequence
a. Go to Task Sequence>New Task Sequence

@ Leploymentworkpencn - |Leployment Workbench\Leployment Shares\IViL | Leployment Share (Lx\Leployment
File Action View Help

ez H

ﬁ Deployment Workbench
» [} Information Center
v [ Deployment Shares There are
v {2\ MDT Deployment Share (D:\DeploymentS|
» [ Applications
El Operating Systems
> m QOut-of-Box Drivers

Name ID

> Lk Packages
> L Task Sequer---
> [ Advanced ( New Task Sequence %
> [?l Menitoring New Folder
View >
Refresh
Export List...
Help

b. Define the ID and Name:

New Task Sequence Wizard X

@ General Settings

Specify general information about this task sequence. The task sequence ID is used intemally as part of the
deployment process. The task name and are displayed by the depl wizard.

Task sequence ID:

Win10v1

Task sequence name:
|\'|ﬁnduws 10 Pro Upgrade|

Ta.d(se]kﬁence-_

Previous Cancel




c. Leave the following:

New Task Sequence Wizard

@ General Settings

General Settings
Select Template
Select 0S

Specify Product Key
0S Settings

Admin Password
Summary

Confimation

Specify general information about this task sequence. The task sequence ID is used intemally as part of the
deployment process. The task sequence name and comments are displayed by the deployment wizard.

Task sequence ID:

Win10v1

Task sequence name:
[Windows 10 Pro Upgrade]

Task M comments:

d. Choose the OS you added in the previous section:

The following operating system images are available to be deployed with this task sequence. Select
the one to use.

EJD Operating Systems

S8 Vicrosoft Windows PE (x64) in Uparade Win 10 boot wim

.= Microsoft Windows Setup (x64)in Upgrade Win 10 boot wim




e.

f.

Do not specific a product key:

® Do ot speciy & product key at this time.

Aproduct key is not required when deploying Windows 7, Windows Server 2008 R2. or later 0S
versions, or f the product key will be specfied at deploy time using the wizard or 8 nie.

) Specy a mutiple activation key (MAK key) for activating this cperating system.

In crder to activate, aach computer deployed using this MAK key will need 1o contact the Microsolt
activation service on the intemet. This is only for Windows 7 and later opersting systems
when using volume icense media.

) Specky the product key for this operating system.
Specfy a retad product key. (Note that retal keys can only be used to activate 3 single machine )

Enter your custom settings:

New Task Sequence Wizard

3 0S Settings

General Settings Specify settings about this task sequence. These settings will be used for all deployments of this task
sequence, unless ovemidden dunng the deployment process using the wizard or a rule.

Select Template
Select 0S
Specky Product Key fil b
|Upgradewin10 |
Admin Password
Summary O
Confimation
Intemet Explorer Home Page:
[ googe conl ]

| Prevous | [ Net || Cancel |




g. Specify the admin password:

. e

General Settings Specfy the local Administrator password for this task sequence.
Select Template
Select 05 @) Use the speciad local Administrator password.

Specty Product Key Adrazratec Passwors

) Do not specy an Administrator password at this time.

The local Adminstrator password wil be duning the deployment of this task sequence.sot s
not needed as pant of the task

[ Prevos || Net || Concel |

h. You will see your summary page:

? Summary
General Settings Al of the necessary detalls have been specified. Please review the values below.
Select Template
Select 0S Detals:
Specify Product Key .
0S Settings TaskSequencelD: Win10v1
Admin Password TaskSequenceName: Windows 10 Pro Upgrade
IsUpgradeTS: False

Progress Template: Custom xml
Confimmation

Click next to execute the requested action.

| prevos [ Nea ]| Cmes |




i. Click Finish to see the following:

a DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D:\DeploymentShare)\Task Sequences]
File Action View Help

e 258

T Deployment Workbench Name D Versiol

> [} Information Center [Z) Windows 10 Pro Upgrade WIN1OV1 1.0
v [ Deployment Shares

v [ MDT Deployment Share (D:\DeploymentS|
» [ Applications
m Operating Systems
> [ Out-of-Box Drivers
> L Packages
L} Task Sequences
» [ Advanced Configuration
> m Monitoring

j. You can configure additional settings by right clicking on the task sequence and going to
properties:

General | Task Sequence | 0 info |
Sk Add | X Remove & Up © Down Properties | Options

New Group Al e [Restan ]
Generd, Run Command Line
Disks Run PowerShell Script
Images Set Task Sequence Vaniable
Settings Restart computer
Roles Gather
TGO .
(<) Enable BeLocker Install Updates Offline
) nject Drivers Vahdate
Aoply Patches -
Net Install Application
= 2 Postinetal E Orch Runbook
Copy Scrpts
Configure
Inject Drivers
Add Windows Recovery (WinRE)
Next Phase

lestart computer ]

v v v v -

&) Gather local orly @
Post-Apply Ceanup
Recover From Doman

() Tattoo

@ Opt Into CEIP and WER

& Windows Update (Pre-Application inst

&) inatal Apphcatons o

- L

< - > Microsoft Deployment Toolkit 2w microsoh com/mat

[ ok || Comce || &y || Hew




Create MDT Deployable Image

1. Crete a Deployable Image:

a. Right click on your deployment share and select Update Deployment Share

ﬁ DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D:\DeploymentShare)]

File Action View Help

o9 x|z H

ﬁ Deployment Workbench
> [} Information Center
~ [ Deployment Shares

> (& Out-o View
» L Packa

[ Tasks  Refresh
> [ Advar Export List...

> [a Monit

Properties

Help

Name

[% Applications
i Onerating Systems

v A %DTA::E( Update Deployment Share »f-Box Drivers
b
m Opera Close Dephrment Share iges

Sequences
nced Configuration
toring

b. Choose the following:

Update Deployment Share Wizard

0 o

‘When updating the deployment share, the latest tools will be copied to the deployment share. ¥ any changes
have been made to the boot image settings or to the content that needs to be included in the boot image,
those updates will also be made.
I necessary, you can choose to completely regenerate the boot images, or to compress the existing boot
(® Optimize the boot image updating process.

[[] Compress the boot image contents to recover space used by removed or modfied content.
(O Completely regenerate the boot images.

== ==




c. Complete till wizard completion:

=

Mourting WIM fie
Summary
5 D = 5
e =

=== Making sure the deployment share has the latest X85 tools ===
=== Processing Lte TouchPE (x86) boot image ===
Buiding requested boot mage profile

Determining # any changes have been made in the boct mage configuration
(No existing boot image profile found for platiorm x86 50 a new image wil be created

hashes for requested contert
IChanges have been made. mage wil be updated
IWindows PE WIM C Fles (B6]\Windows Kts\10\A ¢ and Depk K2\Windows |
<| L] | >

d. If you got to your Deployment share in your D: Drive>Deployment Share>Boot>x86, you
will see you .WIM file now

v | unu — N
me Share View v o Actions
1 « Temporary Storage (D;) » DeploymentShare » Boot v O | Search Boot »p m
Name Date modified Type Size Upd
ccess Clos
x64 4/6/2019 5:56 PM File folder .
op + Viev
x86 4/6/2019 5:53 PM File folder
loads » ~ G Refr
LiteTouchPE_x64 4/6/2019 5:59 PM Disc Image File 376,
t » 2
nems [ LiteTouchPE_x64.wim 4/6/2019 5:59 PM WIM File 3341 = Expt
&s # ¥ LiteTouchPE _x64 4/6/2019 5:59 PM XML Document Proj
£ LiteTouchPE_x86 4/6/2019 5:56 PM Disc Image File 3054 Helj
Jsource D LiteTouchPE x86.wim 4/6/2019 5:56 PM WIM File 263,
ws 10 1SO &) LiteTouchPE x86 4/6/2019 5:56 PM XML Document
op B




Add Boot Images to WDS

1. Open WDS
a. Server manager>Tools>Windows Deployment Services

! Windows Deployment Services Windows Deployment Services

4 33 Servers
D w2012r2dep.deploy.com
k» 1 Install Images 0 Windows Deployment Services
b 4 Boot Images
b 1 Pending Devices Windows Deployment Services enables you to deploy Windows operating systems over the network.
» .‘0 A TH Thes Microsoft Management Console (MMC) snap-in enables you to manage and configure Windows Deployment
I Services. You can perform tasks including adding images, configuning mult; L and configuning server
b (m Active Directory Prestaged Devices properties. You can also manage your server using the WDSUTIL line tool. For more inf press F1,

To manage a server from this snap-in, you must add it first. To add a serves, right-click the Servers node, and then
click Add Server.

b. Right Click Boot Images>Add Boot Image

- WINGOWS UEPIOYITIENT SETVICES e
File Action View Help
e 2(m = B

§ Windows Deployment Services Boot Images :
4 i Servers Image Name  Architecture  Status = Sze Dste  OSVersion Priori
4 D w20122dep.deploy.com Expanded ocy
p 0 Install Images There are no items to show in this view.
b 4 Boot

b 1 Pending Devices
b & Multicast Transmissions
b 5 Drivers
b _m Active Directory Prestaged Devices

= *

Enter the location of the Windows image file that contains the images 1o add.

! | =

Note: The defaut boot and instal images (Boot wim and install wim) are located on the
installation DVD in the \Sources folder.

b

More rfommation about images and mage tvpes

T




c. Find the WIM file under D: Drive>Deployment Share>Boot>x86

2|
=0 e

@ - 1 I‘ « New Volume... » DeploymentShare » v O] l Search DeploymentShare

Organize ¥  New folder

1% This PC

-~

Il Desitop
8 Downloads
. Recent places

e Desktop
| Documents
& Downloads
¥ Music
& Pictures
B Videos

e Local Disk (C) |
u New Volume (D:)

v

Fiemmc[

J. SOEMS

3 Applicat
4 Backup

&
& C

4 Control

). Operating Systems
4. Out-of-Box Drivers
4 Packages

4 Seripts

4 Servicing
4. Templates

Date modified

10/17/2015 6:47 PM
10/17/2015 6:47 PM
10/17/2015 648 PM
10/17/2015 7:08 PM
10/17/2015 6:47 PM
10/17/2015 &52 PM
10/17/2015 647 PM
10/17/2015 647 PM
10/1772015 647 PM
10/17/2015 &47 PM
10/17/2015 6:53 PM
1/17/2015 6:47 PM

<|

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder

>

v| |Windows image fies ("wim) v |

| Open

Cancel

Deploy the Windows 10 Image

1. Verify Configuration Settings in WDS
Right Click on your Deployment share, click Properties, then go to sharing

a.

New Volume (D:)
Share View
ca » ThisPC » New Volume (0:) v & [[searchNewv:
Name b Date modified Type Sae
s
£ & so
e & Generd Previous Versions | Customze
& W2012R2Source
bwinosouce || ) P ooz ,
e Tive Pl fokder
" Locaton: [ AN
Sae 496 GB (5.330.527,506 bytes)
Sceondsk 496G (5335687163 bytes)
e Cortans:  2.404 Fles. 399 Foldens
me (D)
Crested  Seturday, October 17. 2015, 6.47.21 PM
Aerbutes (8] Readonly (Only spples to fies in folder)
[§ () Hdden [ Advnced |
n selected
[ox ] ooy | [l

~




C.

b. Go to Advanced Sharing

control:

Genersl  Shamg | Securty | Previous Versions | G

Network File and Folder Shamng
Deployment Share
Shared

Network Path
\\W2012R2DEP\Depioyment Share$

Advanced Shamng

Set custom permssions, create mutiple shares, and set cther
advanced shanng cptions

BT

Click on permissions and make sure you have the correct Administrators with full

PRTV T O R TR S

Deploymentshare Properties | X |/




d. Right Click on the Server>Click Properties>Click Advanced:

oo 2E = B
@ Windows Deployment Services
4 33 Servers
4 b w2012r2dep.deploy.com
b 1 Install Images
b (&) Boot Images
b .5 Pending Devices
b & Multicast Transmissions 5 W2012R20EP
b 4 Drivers
- Devic
& Active Directory Prestaged £ P
Remcte nstallaton
folder:
Server mode
MD

e. Authorize the following:

(@ Alow Windows Depk
~ domain servers pecommended)

() Windows Deploymert Services should uss the following servers.
Domain controler: Browse
Global catsiog: Erowse

DHCP Authorzation
Oggmn Deployment Servicas sarver in

@ Authorize this Windows Deployment Services server in DHCP

R

b
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End-User Experience

We first want to test out the deployment with our 2 pilot devices. When we boot them up, it will PXE
boot onto the system, and the user will be prompted to press f12 for a network service boot.

a. From there they will be asked to choose the boot image:

Choose an operating system to start:
(Use the arrow keys to highlight your choice, then press ENTER.)

Lite Touch windows PE (x86) >

Lite Touch windows PE (x64)

Loading files...

[ —

: 192.168.10.10, File: \Boot\x86\Images\LiteTouchPE_x86.wim

b. Run the deployment wizard:

) Microsoft Deployment Toolkit ‘3

A

ks

b Run the Deployment Wizard
to install a new Oper(ting System

Exit to Command Prompt




C.

d.

1S 1K

Define the deployment share path that you copied when you first configured the
deployment share in MDT

‘> Deployment Share

Specify which deployment share to use.
Before this wizard can continue, it will need to know the path of a Deployment Share.

Fggwmm:mwra'\w

W

O

[ gak |[ et |[ concer |

Add your credentials:

¥ Credentials

Specify credentials for connecting to network shares.

User Name ’admwstmor ]
Password: Iooooonl N I
s
Domain l ] * Required (MISSING)

[ gancet |




e. Choose the appropriate settings here based on your environment:

iter Details

oot A compuserrame
Move Data and Settings

User Data (Restore) Q
Locale and Time O Join a domain.
Capture Image ‘
BitLocker Domgin to join:
Ready Qrganizational Unit:
User Name:
Eassword: sesssnnnne
Domain: @

® Join a workgroup.
Workgroup: |workaroup

[ Back ][ met |[ cancel |

f. Move User data and settings:

Move Data and Settings

m Move data and settings from a previous version of Windows?
Move Data and Settings @® Do not move user data and settings.
User Data (Restore) Install a new operating system without retaining any data or settings from any existing
Locale and Time operating systems.
Capture Image
BitLocker Keep existing partitions (do not format or )
Ready }m
Move uger data and settings.

Capture all the user data and settings from an existing operating system on the computer
and restore them into the new operating system.

[ ok ][ dea || conce |




g. Do not capture the image:

Iask Sequence
Computer Details
Move Data and Settings

Locale and Time

~ Capture Image

Specify whether to capture an image.

O Capture an image of this reference computer.
Specify the UNC path where the image should be stored and the file name to use.

Location:

File name:

O Sysprep this computer.
Initiate Sysprep for the operating system, not capture an image (useful when
generating a VHD).

O Prepare to capture the machine.
Copy the needed Sysprep files to the proper location, but do nothing else.

® Do not capture an image of this computer.
This is a normal deployment, 5o an image does not need to be captured.

[ gacx ][ mea ][ concel ]

h. Choose whether or not to enable BitLocker

3itLocker

Specify the BitLocker configuration.
BitLocker can be enabled to provide an additional level of data security for this computer.

® Do not enable BitLocker for this computer.

O Enable BitLocker. Q

® Enable BitLocker using TPM only.
Enable BitLocker using TPM and Pin.

Enable BitLocker using TPM and a startup key. st Available V

Enable BitLocker using only an Extemnal Startup Key.

Choose where to store the Recovery Key.
In Active Directory

® Do not create a recovery key. (Not recommended)

Wait for Bitiocker Encryption to complete on all drives before continuing.

<

b

[ gack |[ Met |[ goncel |




i. Copy the details that you created. We will be using these for our broad deployment so
end-users do not have to configure all of the info

BROAD DEPLOYMENT:

ﬁ

/¥ Ready

Wmm Ready to begin.

Move Data and Settings Using the information you provided, the deployment can now begin.
User Data (Restore)

Locale and Time R Detalls

el TSGuid = “Win10Dep"

Bitlocker DeploymentType = “NQWCOMPUTER"

Ready OSDDiskPartitionStyle = "WINIOADVANCED"

OSDComputerName = “MININT-7LTHKNA"
Demainadmin = “administrator”
Damanionezasers ¥
DomainAdminDomain = *depioy”
JOINWOrkgroup = “WORKGROUP®
USMTOfflineMigration = “FALSE"
UserDatalocation = “NONE"
UlLanguage = “en-us"
UserLocale = “en-us”

y ocale = “en-us:0409:
TimeZoneName = "Central Standard Time*

="

BdeinstallSuppress = “YES*

[ gack |[ segn |[ gancel |

j. Back in the Deployment workbench, right-click on your deployment
share>Properties>Rules>Edit Bootstrap.ini

ﬁ DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D:\DeploymentShare)]

File Action View Help

sz @

ﬁ Deployment Workbench

> L2} Information Center

v LA Deployment Shares
A MDT Depl

¢

> [ Applications

> m Operating Systems

> [i& Out-of-Box Drivers

> Lk Packages

> L3 Task Sequences

> [ Advanced Configuration
> m Monitoring

yment Share (D:\Deployment§

MDT Deployment Share (D:\DeploymentShare) Properties

General Rules  Windows PE Monitoring




k. Paste in your configuration we copied in step “n” under {Default]

] Bootstrap - Notepad
1File Edit Format View Help

|[Settings]
Priority=Default

[Default] ’

L. Update the deployment share to add this configuration

i DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D
File Action View Help

"YEIEY
ﬁ Deployment Workbench
> [} Information Center % Applications

v [a ?eployment Shares I . [1 e —
v | MDT Deployment Share T

Name

> [ Applications 1l 1?“ Share
> [, Operating Systems Close Deployment Share
> [k Out-of-Box Drivers

: Vi 3 Lo
> | Packages - tion
> [ Task Sequences Refresh
> [ Advanced Configuraf Eiport bt
> 13 Monitoring

Properties

Help



m. When you are ready for broad deployment, go back to WDS>Right-click on
your server>Properties>Boot>And click Continue the PXE Boot:

! Windows Deployment Services

File Action

L AR REREYR 7 Bo:

View Help

! Windows Deployment Services
v 3 Servers
v 13 MDTTesting.wrajrecords.com
> | Install Images
> [4<] BootImages
> [1% Pending Devices
> 5} Multicast Transmissions
> [ Drivers
" Active Directory Prestaged Device

MDTTESTING Properties

Multicast Advanced Network
General PXE Response AD DS Boot Client
PXE Boot Policy
After a network boot is initiated, define when a PXE boot will continue.
Known clients:
(O Require the user ss the F12 key to continue the PXE boot
O Aways conti PXE boot
(®) Continue the PXE boot unless the lt?f presses the ESC key
(O Never continue the PXE boot
Unknown clients:
(® Require the userto press the F12 key to continue the PXE boot
(O Always continue the PXE boot
(O Continue the PXE boot unless the user presses the ESC key
(O Never continue the PXE boot

TFTP
DHCP

n. With these settings configured, all of the users in your environment will get
the image pushed to them without having to press f12 or run through the
wizard of setting like we did for out pilot users
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Conclusion

| hope this article provided you some targeted guidance on deploying the Windows 10 upgrade across
your network. Any feedback to improve your experience would be greatly appreciated. | would also like
to hear if there is more content that you would like to see in this guide. Any feedback can be sent to my

email below:

Nick Ross | Solutions Engineer

nross@pax8.com
Direct Line: 720-577-4566

//\’ mc,. www.pax8.com
k paxa 6400 S Fiddlers Green Cir, Ste 1500
g ~ Greenwood Village, CO 80111

— o —

Twitter | Facebook | LinkedIn



http://www.pax8.com/
https://twitter.com/pax8
https://www.facebook.com/Pax8Cloud/
https://www.linkedin.com/company/pax8
https://www.pax8.com/#/newsFeed/Pax8-Named-one-of-America-Fastest-Growing-Private-Companies-by-Inc.

